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Topic 1 
Prepare to create a presentation

Most organisations need people with skills in designing and producing 
electronic presentations. 
Sharing information is a necessary activity in every workplace. You may have to take part 
in a staff meeting or read a newsletter, and you will probably present information at some 
time in your career. Information can be presented in written, graphic or verbal form. You 
need to be able to communicate in all of these ways and know how to use a range of business 
equipment and technology safely and effectively. 

To work effectively in this area, you need to prepare your workspace by understanding safe 
work practices and by knowing how to identify hazards or risks to reduce workplace injury. 
While a lot of the responsibility for workplace safety lies with the employer, employees must 
also make an active contribution to ensure their workplace is safe. 

To prepare a quality presentation, you must also be well informed. You need to take the time 
to understand the purpose of the presentation, which includes knowing who it is for (the 
audience), how it should be presented and in what format. Being well informed helps you to 
create a relevant and professional presentation. 

In this topic you will learn how to:
1A	 Use safe work practices
1B	 Determine the purpose, audience and method of presentation
1C	 Identify the task requirements and use the best application
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Workplace safety is everyone’s responsibility. 
Both employers and employees must make an active 
contribution to ensuring their workplace is safe. 
Hazards need to be identified and risks assessed 
to reduce the risk of injury in the workplace. If 
you are working at a computer for an extended 
period of time each day, your workstation must be 
comfortable and designed to help you carry out 
your tasks efficiently. You will need to organise your 
work so that you are not doing a repetitive task for 
a long time. You should also take regular breaks to 
stand up and stretch. 

Another consideration is to use resource 
conservation techniques to prevent wastage. Most 
organisations require staff to follow resource-saving 
procedures such as turning off lights in unused 
rooms and recycling paper. You need to be aware of 
any conservation efforts made by your organisation.

Health and safety legislative requirements
You must work in line with legislative requirements, regulations, Australian and 
industry standards, and the relevant codes of practice.
All health and safety legislation requires employers to provide a safe workplace and 
adequate training and supervision, while controlling workplace hazards and risks. 

Health and safety regulations support the legislation by outlining specific health and safety 
requirements that must be addressed.

The Model Work Health and Safety (WHS) Regulations provide a framework that has been 
adopted by all Australian states and territories except for Victoria and Western Australia, 
which have their own legislation and regulations. 

Australian and industry standards provide best-practice guidelines for maintaining 
health and safety in the workplace. For example, AS/NZS 4443-1997 Office panel systems 
– Workstations outlines the ergonomic requirements for setting up a workstation in a 
workplace.

Health and safety legislation outlines legal requirements such as:

•• managing risks to health and safety
•• promoting and maintaining the health, safety and welfare of people at work
•• protecting people at work from injury and illness, including psychological injury
•• protecting the health and safety of the public in workplaces
•• consulting workers and encouraging them to maintain health and safety
•• providing rehabilitation and maximum recovery for injured workers.

Ergonomics is an important part of 
workplace safety.

1A	 Use safe work practices
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Audience
If you take time to get to know your audience, the electronic presentation you 
develop will be more successful. 
Find out who your audience is and what their 
information needs are; for example:
•	 Is it an internal or an external client?
•	 Does the group all come from the same unit/site 

or do the same job?
•	 What will they need to do after they have seen 

the presentation; for example, will they need to 
practise a task or skill as part of your planning?

•	 Are there any people with disability or 
cultural issues that should be considered when 
delivering the message?

•	 What sort of presentations worked best for the 
group previously?

It is also important to find out what level of expertise your audience members have in regard 
to your subject. If your audience is not knowledgeable about the content of your presentation 
and you include fine details and jargon, people may become confused and bored. If you are 
presenting to an external client, ask your manager for information about them. If you are 
presenting to an internal client, you could prepare a questionnaire to find out their level of 
existing knowledge.

Method of presentation
Whatever presentation method you choose, the way you arrange the 
information will depend on the situation. 
The method you choose must suit both the purpose of your presentation and the audience, 
and should enhance the audience’s ability to understand it. You need to hold the audience’s 
attention and ensure that your information is easy to understand. You need to consider the 
most useful method for the audience to receive the information and retain it, rather than 
assuming it will be enough if they’ve seen it.

Here are several different ways to give a presentation.

Face to face

└└ Presenting information face to face to an audience, such as at a seminar or a staff 
meeting.

Specialist speaker

└└ Engaging a specialist speaker/demonstrator for certain aspects of the presentation.
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Self-running

└└ Choosing a ‘self-running’ mode, such as a looped video that runs continuously on a 
TV monitor at an exhibition stand. 

Self-paced

└└ Designing a presentation for people to use themselves, such as at a conference, 
training session, or in their own time at their desk. It may include activities to assess 
their understanding of the tasks or material.

Online

└└ Setting up the presentation on the internet or the organisation’s intranet. This 
enables you to record the identity of the user/participant and acts as a method 
of tracking and ensuring information has been accessed by relevant participants 
wherever they are located.

Sent via email

└└ The presentation can be saved as a PDF and sent as an attachment. It can be viewed 
when the participant chooses to watch the presentation. 

Practice task 2

Read the case study, then answer the questions that follow.

Case study
Kate works as an office administrator in a large organisation. Her manager asked her to prepare an 
electronic presentation for external clients to explain upcoming projects. The clients were to view the 
presentation at a board meeting.
Kate assumed the clients already knew a lot about this topic and focused instead on the financial 
costs of each project, including forecasted profits. She also used information that management did 
not want disclosed to the clients and she did not confirm the information with management. Kate set 
up a computer with a digital projector in the boardroom. The clients were to come in and look at the 
presentation individually when they had time in the days leading up to the board meeting. 
On the day of the board meeting, Kate found out the clients had no prior knowledge of the projects 
and wanted a broad overview. She also discovered that the clients had difficulty working the 
technology and were either unable to access the presentation or required assistance from others. 
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Production guidelines are used to develop time lines and a consistent 
organisational style. 
A time line is used to ensure there is enough time 
to complete the task, edit and review before the 
deadline is reached. A time line is a plan for how 
long a task will take to complete. It also breaks the 
task into steps and details when each step needs to 
be completed by. Your supervisor will often provide 
a date, but it will be your job to monitor and report 
on your progress. 

Production guidelines also ensure that documents 
have a consistent style and image so that customers, 
business associates and anyone receiving material 
from your organisation will instantly recognise it 
as belonging to your organisation. These output 
requirements are important because each time a 
client has contact with an organisation, they form 
an opinion based on the documents they receive. 
In some instances an unprofessional-looking document or one containing errors can be the 
difference between gaining and losing a client.

Many organisations have policies and procedures for staff to follow, including style 
guides and templates for producing documents. In larger organisations and government 
departments they are usually clearly defined, while smaller organisations often have no 
formal documented style guide; instead, staff may be expected to follow examples of 
documents that have previously been produced.

Conforming to organisational requirements will also ensure you are able to complete your 
work in an efficient and timely manner. It is very frustrating to spend hours working on the 
design of a document, only to find it does not meet requirements. To avoid a situation like 
this, there may be a simple template you could use. Speak to a colleague or your supervisor 
if you are unsure.

Common organisational requirements
Every organisation has different requirements for their documents. 
One important requirement is to present an appropriate and consistent corporate image by 
using the organisation’s logo, colour scheme and house style.

Most organisations outline document production procedures and guidelines either in their 
policies and procedures manual, or in an in-house style guide. Make sure you know where 
these instructions are kept and that you are familiar with them. Your supervisor can assist 
you to find the correct template, identify where the style guide is stored and rules about 
its use. 

The requirements appropriate for one organisation may not suit another; for example, a law 
firm’s requirements would be different from that of a sports equipment retailer. 

Ensure you comply with your 
organisation’s requirements and 
guidelines.

1C	 Identify the task requirements 
and use the best application
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To add an illustration, go to the Insert tab and click SmartArt. 

In the dialog box, click the type and layout you want. You can enter your text either by 
clicking in a shape in your SmartArt graphic and typing your text in directly or by opening 
the Text Pane from the Design tab under SmartArt Tools. The text you enter for each bullet 
point will appear in different parts of your SmartArt graphic.

Animation
Apply animation sparingly to prevent obscuring your message or 
overwhelming your audience.
However, you may wish to add animation to your SmartArt graphic to draw the viewer’s 
attention or stimulate interest. For example, you can make a shape fly in from one side of 
your screen or slowly fade into view. 

To decide which animation works best with the layout for your SmartArt, view your 
information in the SmartArt graphic Text Pane, since most animation starts at the top of 
the Text Pane and moves down. You can also play an animation in reverse order.

The animations that are available depend on the layout you choose for your SmartArt 
graphic. 

To animate your SmartArt graphic, click on it then go to the Animations tab and select the 
animation you want to apply. You can customise an animation using Effect Options in the 
Animation section. Here, you can choose to animate all of the shapes in the SmartArt at 
once or one shape at a time.

To add sound, go to the Animations tab and select Animation Pane. A panel will appear on 
the right. Click the arrow next to the and select Effect Options from the drop-down menu.

In the dialog box, click the arrow next to Sound, then either select a sound from the list or 
select Other Sound… to locate a sound file on your computer.

Animated items are noted on the slide by non-printing numbered tags. These tags 
correspond to the animations in the Animation Pane, which appear only in Normal view 
with the Animation task pane displayed.

You can view your animations at any time by going to the appropriate slide and clicking the 
Preview button in the Animations tab. 
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Topic 3 
Finalise presentations

The quality and content of your electronic presentation reflects the 
professionalism of your organisation. 
To complete a professional presentation to a high standard, you need to ensure that your 
presentation is carefully proofread and that all associated printed materials are accurate and 
informative. They need to be checked to make sure they meet style and layout specifications. 

You need to allow time to edit and proofread before they are printed, published or 
distributed. You may need to check style and layout specifications and look out for spelling 
and grammatical errors.

Electronic presentations need to be saved and stored securely to eliminate the possibility of 
loss or damage of data and information. There are several methods of ensuring safe storage. 

In this topic you will learn how to:
3A	 Proofread your presentation
3B	 Finalise and print your presentation 
3C	 Store your presentation
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AutoCorrect
The AutoCorrect function in PowerPoint 2016 is a default setting of common 
misspellings and symbols, which you can modify. 
This feature corrects typos and misspelled words, and inserts symbols and other pieces of 
text. Text included in hyperlinks is not automatically corrected.

The AutoCorrect feature also includes a series of parallel lists, where a particular word typed 
can be automatically replaced by another word.

For example, the AutoCorrect feature can be used to:
•	 automatically correct typing errors and misspelled words; for example, if you type ‘teh’ 

instead of ‘the’
•	 insert symbols; for example, you can type :-) to insert a smiley emoji

To adjust AutoCorrect settings, go to the File tab and select Options. Click on the Proofing 
tab and select AutoCorrect Options. Here you can add, delete and amend AutoCorrect 
options.

To add an entry to the list of automatic corrections, select the AutoCorrect tab. In the 
Replace box, type a word or phrase that you often mistype or misspell (e.g. ‘usualy’). In the 
With box, type the correct spelling of the word (e.g. ‘usually’). Click Add.
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Network/operating system logons and security 
Passwords may be required to ensure that only authorised users are able to 
access certain files and information. 
Access to an organisation’s data can be controlled at a number of levels, including drives and 
files. Employees can be given access to shared directories or individual files.

Most organisations have networks made up of multiple computers. Before employees can 
use a computer that is connected to the network, they must be issued a login username and 
password, which identifies them and allows them to access the files on the network. Below 
are the instructions for selecting a password and keeping your work secure. Your IT support 
person should be able to give you advice on this. Alternatively, refer to the organisational 
policies and procedures for password protection. 

Selecting a good password

You should change your password on a regular basis and ensure you do not tell anyone 
what it is. Your password should not be anything that can be easily guessed by other 
people, such as your date of birth, name, family members’ names, etc. Good passwords 
contain a mixture of letters and numbers and are least six to eight characters long. 

Protecting individual files

Depending on the network configuration, employees will have their own drive for 
their files along with access to various shared drives. Where files contain sensitive 
information that should not be accessed by all employees, you can apply a password to 
an individual file. Two levels of access can be applied:

•• a password to open the file, which allows the file to be viewed and printed
•• a password to modify the file, which will let the user make changes to the file.
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Learning checkpoint 3 
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Part A
Read the case study, then answer the questions that follow.

Case study
John works for a small not-for-profit organisation. Part of his job is to create a monthly presentation 
to send out via email to the organisation’s clients. The content and format of the presentation 
follows a standard outline, and John’s supervisor is happy with the comments he has received from 
clients about how easy it is to read and understand. John always has a short deadline in which to get 
the presentation prepared because he is often held up waiting for contributions from others in the 
organisation. 
John thinks the presentation looks outdated and has decided that he will change the style by 
changing the font type and adding some bright images and the logo in the footer. John wants to show 
his boss he has initiative, so he doesn’t get a colleague to proofread the presentation as he normally 
would. 

1.	 What instructions should John follow to produce the presentation?

2.	 Do you think John is right to make changes to the presentation?




